RE N ESAS Application Note

e? studio Integrated Development Environment

Debugging Linux Applications Running on the R-Car (with the DTA as an
Analysis Tool)

Introduction

This application note introduces the procedure for acquiring trace data of R-Car V4H through the command-
line interface (CLI) of Linux which is running on an R-Car and displaying the data in the debug trace agent
(DTA) trace window for use of the e? studio for R-Car.
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e2 studio Integrated Development Environment Debugging Linux Applications Running on the R-Car
(with the DTA as an Analysis Tool)

1. Environment
The following lists the elements of the environment used in the descriptions in this application note.

Table 1-1 List of Environment Elements

Item Detail
R-Car V4H Reference Board White Hawk
[RTP8A779G2ASKBOF10SA001]
Host PC o Windows 10 (for use of the terminal display console or running

Linux in a VirtualBox virtual environment)
e Ubuntu 20.04 LTS (e? studio, TFTP server, or NFS server)

e? studio for R-Car Version 2023-03
rcar-xos_tool_e2studio_ubuntu_2023-03.R20230313-1010.tar.gz
R-Car V4H SDK V3.12.0

rcar-xos_developer-adas-bootloader_v3.12.0_release.tar.gz
rcar-xos_platform-sdkX_v3.12.0_release.tar.gz (sample source code)
R-Car V4H yocto Linux V5.10.147

(Kernel version) rcar-xos_tool_yocto_linux_6.13.0.tar.gz

This application note describes the procedure for using an environment in which a Linux environment has
been set up for the R-Car on the reference board. For the procedure for setting up the Linux environment,
refer to the user’s manual included in the SDK.

2. Connection Diagram

Figure 2-1 shows a connection between the reference board for the R-Car V4H and a host PC. The IP
addresses for use between the host PC and the reference board are set as shown in the figure. Specify the
IP addresses which are to be set to suit the environment you are using.

USB type Ato micro-USB cable

e’ studio

Ethernet cable

T [

IP address: IP address:

- 192 168.0 1 192 165.0.20

H 3 -
- LN

Windows/LinuxHOSTPC > s )
TFTP
NFS ss:rr:;rr R-Car V4H Reference Board
SSH

Terminal software to display console

Figure 2-1 Connection between the Host PC and the Reference Board
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e2 studio Integrated Development Environment Debugging Linux Applications Running on the R-Car
(with the DTA as an Analysis Tool)

3. Preparing Trace Data for the DTA

3.1 Starting Linux which Runs on an R-Car

Turn on the R-Car V4H and start Linux after reading an image for Linux running on an R-Car from the host
PC.

The following shows the boot log messages in the serial console.

Using ethernet@e6800000 device

TFTP from server 192.168.0.1; our IP address is 192.168.0.20
Filename 'Image'.

Load address: 0x48080000

Loading: #########444###H44#FHAAEHFHIHHEHFHIHHAAHHIHEEHHHIHEAHH SR AESHH SIS

FHEHEH AR R
4 MiB/s
done
Bytes transferred = 33839616 (2045a00 hex)
Using ethernet@e6800000 device
TFTP from server 192.168.0.1; our IP address is 192.168.0.20
Filename 'r8a779g0-whitehawk.dtb'.
Load address: 0x48000000
Loading: ########4#
2.8 MiB/s

Done

Figure 3-1 Preparing Data (1)

After the image for Linux running on the R-Car has been started, log in to Linux to confirm its version.

After images of Linux running on R-Car has been started, log in Linux to confirm its version.
[ OK ] Started Target Communication Framework agent.
[ OK ] Started Avahi mDNS/DNS-SD Stack.
[ OK ] Reached target Multi-User System.
Starting Update UTMP about System Runlevel Changes...

[ OK ] Started Update UTMP about System Runlevel Changes.

Poky (Yocto Project Reference Distro) 3.1.11 v4dx ttySCO

v4x login: root (Enter the password and press [Enter].)
root@véx:~#

root@vé4x:~# uname -a (Enter the command and press [Enter].)

Linux v4x 5.10.147-yocto-standard #1 SMP PREEMPT Fri Mar 3 11:25:12 UTC 2023 aarch64 aarch64 aarcho64
GNU/Linux

root@vix:~#

Figure 3-2 Preparing Data (2)
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e2 studio Integrated Development Environment Debugging Linux Applications Running on the R-Car
(with the DTA as an Analysis Tool)

3.2 Preparing an Executable File for Acquiring Trace Data

When the e? studio is installed on the host PC, a pre-constructed stub file is stored in the DebugComp/RCar
directory of the e? studio. The path name is given below.

“lhome/<user name>/.eclipse/com.renesas.platform_XXXXXXXXXX/DebugComp/RCar”

XXXX@XXXXXp:~$ 1ls =-alF (Enter the command and press [Enter].)
total XXXXXX
drwxrwxr-x 9 XXXX XXXX XXXX MMM DD HH:MM ./

drwxrwxr-x 3 XXXX XXXX XXXX MMM DD HH:MM ../

-rw-rw-r-- 1 XXXX XXXX 572088 MMM DD HH:MM perfmodule2-5 10 0.ko

—rw-rw-r-- 1 XXXX XXXX 575584 MMM DD HH:MM perfmodule2-5 10 41.ko

—rw-rw-r-- 1 XXXX XXXX 494048 MMM DD HH:MM saperfmon.elf

-rw-rw-r-- 1 XXXX XXXX 630592 MMM DD HH:MM saperfmon vh4.elf

XXXXE@XXXKXXp:~$

Figure 3-3  Preparing Data (3)

Select “perfmodule.ko” and “saperfmon.elf’ corresponding to the version of Linux running on the R-Car and
the target board. Store these files in the desired working directory of Linux.

Note that the following files are used in this environment.

e impsample core link (sample application for adding DTA messages to the trace data)
e perfmodule.ko (file for operating an elf file)

e saperfmon.elf (executable file for acquiring trace data)

Figure 3-4  Preparing Data (4)
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e2 studio Integrated Development Environment Debugging Linux Applications Running on the R-Car
(with the DTA as an Analysis Tool)

Store the files in the desired directory of Linux running on the R-Car and assign the executable right to the
files to be executed.

root@v4x:~/XXXXXXXX# chmod 755 ./saperfmon.elf ./impsample_core_link (Enter the command and press [Enter].)
root@v4x: ~/XXXXXXXX#
root@v4x:~/XXXXXXXX# ls -alF (Enter the command and press [Enter].)

total XXXX
-rwxr-xr-x 1 root root XXXXXX HHH DD YYYY impsample core_link*
-rw-r--r—-- 1 root root XXXXXX HHH DD YYYY perfmodule.ko

-rwxr-xr-x 1 root root XXXXXX HHH DD YYYY saperfmon.elf*

root@véx:~/XXXXXXXX#

Figure 3-5 Preparing Data (5)
Notes:

e The sample application (impsample_core_link) uses a sample file (rcar-
xos/v3.12.0/samples/impsample_core_link/) included in the SDK.

e The perfmodule.ko and saperfmon.elf files are rebuilt after some source code has been changed with
reference to “DTA_guide.pdf” in the support directory for performance-monitor (/home/<user
name>/.eclipse/com.renesas.platform_XXXXXXXXXX/DebugComp/RCar/performance-monitor).

The performance-monitor directory is generated by starting the e? studio on the host PC, creating the R-Car
project, and proceeding with debugging.

Select [File] -> [New] -> [Renesas C/C++ Project] -> [Renesas R-Car] to open the [New C/C++ Project]
dialog box.

New C/C++ Project o &

Templates for Renesas R-Car Project

All R-Car CMake Project
c/C++ ===~ A CMake Project for Renesas R-Car using selected sample application.

Renesas CC-RH C Executable Project
= AC Executable Project for Renesas RH850 using the CC-RH toolchain.

RHESO

Renesas CC-RH C Library Project
= AC Library Project for Renesas RH850 using the CC-RH toolchain.

Renesas R-Car C/C++ Executable Project (Legacy)
A C/C++ Executable Project for Renesas R-Car (Legacy).

Figure 3-6  Preparing Data (6)
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e2 studio Integrated Development Environment Debugging Linux Applications Running on the R-Car

(with the DTA as an Analysis Tool)

Select “Hello World” as a simple project and click on the [Next] button.

R-Car Project o X
R-Car Project configuration

Create R-Car project of selected type

R-Car V3M Sample Shader C++ Project
| This project demonstrates how Shader core is used to transform images

[MIR-Car Hello World C++ Project ‘
imple Hello World ARM core C++ Project

Figure 3-7 Preparing Data (7)
Enter the desired project name and click on the [Finish] button.

R-Car Project o x
R-Car Project type selection

Create R-Car project of selected type

€. sample

Figure 3-8 Preparing Data (8)

When the created project is displayed in the list of projects, start debugging. Even if debugging fails to start,

a support directory for performance-monitor will be generated under “~/DebugComp/RCar”. Refer to
“‘DTA_guide.pdf’.
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e2 studio Integrated Development Environment Debugging Linux Applications Running on the R-Car
(with the DTA as an Analysis Tool)

For the path to the support directory, open the [About e? studio for R-Car] dialog box and click on the
[Installation Details] button by selecting the [About e? studio for R-Car] item from the [Help] menu.

About e? studio For R-Car o X

) Welcome
@ Help Contents
%" Search

Renesas e* studio for R-Car

Version: 2023-03 (23.3.0)
Build Id: R20230313-1010
{ Show Context Help
. P — Parts Copyright (C) 2010-2023 Renesas Electronics Corp.
Show Active Keybindings... shift+Ct Allrights reserved.
Cheat Sheets...
—— e*studio IDE is an extension of software developed for
p eclipse.org.
# Renesas 'Y — LF T — > ®iEM
%8 perform Setup Tasks...
% Check For Updates

(- Install New Software...

I 8 About e2 studio For R-Car

e?studio IDE is based on Eclipse Platform 4.26 (2022-12)
and CDT version 11.0.0.

Source code for the Eclipse Foundation plug-ins is available
from www.eclipse.org, under the Eclipse Public License
"EPL",

PR TS AP F Y JRp ¥ JRpSSp T ——" T " Y]

C%Eﬁ%@%ﬁ

® Installation Details

Figure 3-9  Preparing Data (9)

The [e? studio for R-Car Installation Details] window will open. Selecting the [Support Folders] tab enables
confirmation of the path to the support directories.

e? studio for R-Car Installation Details o X

Installed Software | Installation History | Features | Plug-ins | Configuration | Renesas Device Supporl Suppork Folders, I
I e? studio support area: file:/home/exec/.eclipse/com.renesas.platform 1815713838/

e2studio download area: file:/home/exec/.eclipse/com.renesas.platform download

Figure 3-10 Preparing Data (10)
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(with the DTA as an Analysis Tool)

3.3 Starting the DTA in Each Available Mode
Start the DTA in the desired working directory of Linux running on the R-Car.

3.3.1 Loading a Module for Operating an elf File

Before starting the DTA, load a module. If an attempt is made to load a module that has already been
loaded, an error message will be displayed.

*To unload a module, run the rmmod command.

root@vix:~/XXXXXXXX# insmod ./perfmodule.ko (Enter the command and press [Enter].)
[ 9382.722569] Perfmodule - Board Type V4H detected (0x5cl2)

root@vidx:~/XXXXXXXX#

root@véx:~/XXXXXXXX# insmod ./perfmodule.ko (Enter the command and press [Enter].)
insmod: ERROR: could not insert module ./perfmodule.ko: File exists

root@vix: ~/XXXXXXXX#

Figure 3-11  Preparing Data (11)
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3.3.2 Operating an elf File for Viewing RAW Messages without Event Matching

When the <-em0> option is specified for the executable file for acquiring trace data (saperfmon.elf), the
trace_ YYYYMMDD_HHMMSS directory is created so that tracing can start. After that, the sample application
(impsample_core_link) is executed.

root@vix:~/XXXXXXXX# ./saperfmon.elf -em0 & (Enter the command and press [Enter].)

[1] 536

root@viédx:~/XXXXXXXX# Current working dir: /home/root/XXXXXXXX (desired directory name)
uio PMU driver 1 auto-detection: /dev/uio369

uio DBSC driver auto-detection: /dev/uio368

uio QOS driver auto-detection: /dev/uio367

Trace directory: /home/root/XXXXXXXX/trace YYYYMMDD HHMMSS

Q0S Flat Event Summary

0 - Merge int (W)

1 - Secure_ engine (W)

V4H config end, reading thread started.
Time translation sent back.

Time translation sent back.

root@vix:~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

<IMP Framework Demo start>

RCAR SOC V4H

ATMLIB Version 2.20.0

IMPFW Version 3.12.0

Execute IMP with IMP core and PSC core
-- OutPutMemory Image data of SPM --

00 00 00 00O 04 00 00O 00O 08 00 OO OO0 OC 00 00 00

FO 10 F4 10 F8 10 FC 10
[RESULT] PASS

<IMP Framework Demo end>

impsample core link return = 0 (OK:0, NG:else)

root@vidx:~/e2studio#

Figure 3-12  Preparing Data (12)
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(with the DTA as an Analysis Tool)

3.3.3 Operating an elf File with Event Matching

When the <-em1> option is specified for the executable file for acquiring trace data (saperfmon.elf), the
trace_ YYYYMMDD_HHMMSS directory is created so that tracing can start. After that, the sample application
(impsample_core_link) is executed.

root@vix:~/XXXXXXXX# ./saperfmon.elf -eml & (Enter the command and press [Enter].)

root@véx: ~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

root@vix: ~/XXXXXXXX#

Figure 3-13  Preparing Data (13)

3.3.4 Operating an elf File with Event Matching, QoS Monitoring, and 1-s Sampling Rate
(100000 * 10 us)

When the <-qevt>, <40, 41, 42, 43 (master of CCIO-4)>, and <-s 100000> options are specified for the

executable file for acquiring trace data (saperfmon.elf), the trace_ YYYYMMDD_HHMMSS directory is

created so that tracing can start. After that, the sample application (impsample_core_link) is executed.

root@véx:~/XXXXXXXX# ./saperfmon.elf -gevt 40,41,42,43 -s 100000 & (Enter the command and press [Enter].)

root@véx: ~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

root@véx:~/XXXXXXXX#

Figure 3-14  Preparing Data (14)

Notes:
e You can confirm that the DTA messages have been added in trace.txt within the
trace_ YYYYMMDD_HHMMSS directory.

DTA EM: Ox11l 0x02 0x00 0x00 0x01 OxOF, printf: , TS: 0x0000000539D08387, EpochTS: 1677858023804397383
DTA EM: 0Ox1l 0x02 0x00 0x00 O0x01l OxOF, printf: , TS: 0x0000000539D083A3, EpochTS: 1677858023804400743
DTA RAW: 0x10 TS: 0x0000000539D098DB, EpochTS: 1677858023805052583

DTA RAW: 0x10 TS: 0x0000000539D098DB, EpochTS: 1677858023805052583

Figure 3-15 Preparing Data (15)
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e You can also confirm that the stream_XXX files have been added within the
trace_ YYYYMMDD_HHMMSS directory.

root@v4x:~/XXXXXXXX/trace YYYYMMDD HHMMSS# ls -alF (Enter the command and press [Enter].)
-rw-r--r-- 1 root root XXX MMM DD YYYY stream 100
-rw-r--r-- 1 root root XXX MMM DD YYYY stream 116

-rw-r--r-- 1 root root XXX MMM DD YYYY stream 117

root@v4x:~/XXXXXXXX/trace YYYYMMDD HHMMSS#

Figure 3-16  Preparing Data (16)

¢ If you execute the sample application (impsample_core_link) after you have executed “saperfmon.elf’, an
error may occur. In such cases, repeat the attempt to execute the application up to about ten times until it
starts.

root@vix:~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

[RESULT] FAIL

<IMP Framework Demo end>

<< [ERROR] R OSAL Deinitialize : code 1024>>
impsample core link return = -1 (OK:0, NG:else)

root@vix: ~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

<< [ERROR] R OSAL Deinitialize : code 1024>>

root@vix:~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

<< [ERROR] R OSAL Deinitialize : code 1024>>

root@vix:~/XXXXXXXX# ./impsample_core_link (Enter the command and press [Enter].)

[RESULT] PASS
<IMP Framework Demo end>
impsample core_ link return = 0 (OK:0, NG:else)

root@vix: ~/XXXXXXXX#

Figure 3-17  Preparing Data (17)
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4. Operations for Debugging

4.1 Creating a “Tracing” Project
Start the e? studio on the host PC and create a “Tracing” project.

Select [File] -> [New] -> [Project...] to open the [New Project] dialog box.

File JEdit Source Refactor MNavigate Search Project RenesasViews Run Window Help

New Shift+AlE+N  P» I Renesas C/C++ Project 4 r
OpenFile... R-Car CMake Project

3 Open Projects from File System... 4 Makefile Project with Existing Code

Recent Files » @ C/C++ Project

™ Project...

Project (Adds C/C++ Nature)

e As ¥ Folder

Figure 4-1  Operation for Debugging (1)
Select [Tracing Project] in the [New Project] dialog box and click on the [Next] button.

The [Tracing Project] dialog box appears. Enter the desired project name and click on the [Finish] button.

New Project o Tracing Project o

Select a wizard Tracing Project

Create a new Tracing project Create a Tracing Project|

Wizards: q
Project n"‘"‘“E:I R-CarV4H_sample_Tracing I

type filcer text
Use default location
» (= General

y ECfces Locat cfe2_stud space/R-Carv4H_:
b (= Java v i
> [ ing

il Tracing Project -

Xamples

Show All Wizards.

®I i concel : ®I < peck o concel

Figure 4-2 Operation for Debugging (2)
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(with the DTA as an Analysis Tool)

4.2 Setting Trace Profiling

Select “Fetch Remote Traces...” from the trace project with the desired name to open the [Fetch Remote

Traces] dialog box.

File Edit Source

% || ¥ | ® ||3s Debug

&5 Project Explorer x B % v

Refactor Navigate Search Project Renes

&5 R-CarV4H_sample Debuc

§ = 0O

b =5 R-CarvaH_sample
+ 1=} R-CarV4H_sample_Tracing
% Experiments [0]

OpenTrace...
Open As Experiment... 4

Import...
% Mew Folder...
* Clear

Import Trace Package...

£ Fetch Remote Traces...
Fetch Remote Logs and Traces

Manage XML analyses...

Apply Time Offset...

Clear Time Offset

47 Refresh F5

Figure 4-3

Operation for Debugging (3)

Click on the [Manage Profiles] button to open the [Preferences (Filtered)] dialog box.

Remote Profile

Select remote profile|

Profile name: | new profile
Nodes:
Into folder:

Options

remote_target_trace_location (ssh://root@192.168.0.20)

Overwrite existing trace without warning

Fetch Remote Traces o X

~ [l Manage Profiles

Next > Cancel

Figure 4-4

Operation for Debugging (4)
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Debugging Linux Applications Running on the R-Car
(with the DTA as an Analysis Tool)

In the [Preferences (Filtered)] dialog box,

figure below.

set the trace profiling for the SSH connection as shown in the

o URI: Specify the root user name and IP address of the target (R-Car V4H reference board).
¢ Root path: Specify the desired directory of Linux running on the R-Car for use in remote tracing.

e Recursive: Select the checkbox.

o Trace type: Select the “R-Car Performance Trace” format.

type filter text

~ Tracing

Remote Profiles

type Filter text

~ Tracing

Remote Profiles

P ®

Preferences (Filtered) o ®
© - -~ 8

type filter text

~ Tracing

Remote Profiles

Preferences (Filtered) 0 ®

Remote Profiles - - 8

type filter text

~ i new profile

Add
~ @ remote_target_trace_location (ssh://root@192.168.0.20)
~  fhome/root/e2studio (recursive) Remove
Import

Profile element details:

Nodename:  remote_target trace_location

URI: ssh:/froot@192.168.0.20
Cancel Applyand Close
Preferences (Filtered) o e
Remote Profiles - v 3

type Filter text

~ & new profile
~ @remote_target_trace_location (ssh://root@192.168.0.20)

~ & /home/root/e2studio (recursive) Remove

Import

profile element details:

Root path:  /homefroot/e2studio

Recursive

Cancel

Apply and Close

Remote Profiles

type filter text

- Bnewprofile T
~ (@ remote_target_trace_location (ssh://root@192.168.0.20)
~ (2 /home/root/e2studio (recursive) Remove
Import
Profile element details:
File pattern:  *
Tracetype: = Common Trace Format : R-Car Performance Trace A
Cancel Applyand Close

Figure 4-5

Operation for Debugging (5)

Click on the [Apply and Close] button in the [Preferences (Filtered)] dialog box to return to the [Fetch Remote

Traces] dialog box.
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(with the DTA as an Analysis Tool)
4.3

Importing Trace Data
Click on the [Next] button in the [Fetch Remote Traces] dialog box.

Fetch Remote Traces
Remote Profile

Select remote profile

Profile name: | new profile

« || Manage Profiles
Nodes: remote_target_trace_location (ssh://root@192.168.0.20)
Into Folder: /r-ca

Options

Overwrite existing trace without warning

@ Next > Cancel
Figure 4-6  Operation for Debugging (6)

Select the required trace type and import all items except for the text log. After that, click on the [Finish]
button.

Fetch Remote Traces
Remote Traces

Select traces from remote node

~ B @ remote_target_trace_location (ssh://root@192.168.0.20)
v B /home/root/e2studio (recursive)
» B trace_20230303_153655
» B trace 20230303_161349
~ @ & trace 20230303 _172338
83 5| metadata

=] stream_250

B Etrace.txt

Select All| | Deselect All

@ <Back Next > Cancel
Figure 4-7 Operation for Debugging (7)
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4.4 Displaying Trace Data

A trace directory is displayed in the trace project. Right-click on the name of the trace directory and specify
“R-Car Performance Trace” as the trace type.

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

& | 15 Debug 7 R-CarV4H_sample DebugOr i o v ~ © | New Connection... - | bt ,

5 Project Explorer x 5% v § = O
b =5 R-Carv4aH_sample
~ =% R-Carv4H_sample_Tracing
2 Experiments [0]
- 2 Traces [3]
~ [ remote_target_trace_location [3]
v (% e2studio [3]
= trace_20230303_161349 & Open AllRE L
¢ trace_20230303_172338|  ©OPenAs Experiment... b

Export logfile...

iE Copy... Ctri+C

[ Rename... F2

# Delete

w8 Export Trace Package... )

Select Trace Type... 4 Common Trace Format 4 Generic CTF Trace

Apply Time Offset... DTA Trace LTTng UST Trace

Clear Time Offset RH Trace Linux Kernel Trace

& Refresh F5 Trace32 HSSTP Trace I R-Car Performance Trace
Description ‘ # Manage Custom Parsers...  |rce Path Locat

Figure 4-8 Operation for Debugging (8)

Double-clicking on the “trace_ YYYYMMDD_HHMMSS?” directory in the trace project displays a list of tracing
operations.

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

A || 4 +# Debug [ R-CarV4H_sample DebugOr (iR D - ~ & New Connection... o | 8N v Biw it @~ I P 4 e
5 Project Explorer x B % % § = 8 [ remote_target_trace_location/e2studio/trace_20230303_153655 x = B
» &5 R-CarV4aH_sample Timestamp Event type Core Event Type Linked Core Algorithm valid Algorithm Contents
~ [} R-CarV4H_sample_Tracing - o
<srch> srch> <srch> <srch> srch> srch> srch> srch>
# Experiments [0] . .
- 9 Traces 3] 1677858023804186423 EM IMPO  START WORK Yes 1 ip_name=0, event_type=1, event_ip_use=0, e\
. 1677858023804281223 EM IMPO ENDWORK Yes 1 ip_name=0, event_type=2, event_ip_use=0, e
~ (¥ remote_target_trace_location 3] . A
9 ezstudio [3 1677858023804371223 EM PSCO  START WORK Yes 2 ip_name=16, event_type=1, event_ip_use=0,
~ (2 e2studio
1677858023804374823 EM PSCO  SLEEP IMPO Yes 2 ip_name=16, event_type=3, event_ip_use=1,
trace 20230303_153655 . R
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Figure 4-9  Operation for Debugging (9)
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Double-clicking on “System Performance — DTA Trace” in the trace project opens the view for the DTA.

The content of tracing selected from the list of tracing operations is displayed in the view.

File Edit
LYK # Debug
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1677858023804374823 EM PSCO  SLEEP IMPO Yes 2 ip_name=16, event_type=3, event_ip_u:
1677858023804378663 EM PSCO WOKENBY  IMPO Yes 2 ip_name=16, event_type=4, event_ip_u:
1677858023804386823 EM PSCO  ENDWORK Yes 2 ip_name=16, event_type=2, event_ip_u:
1677858023804394023 EM CNN  ENDWORK Yes 15 ip_name=17, event_type=2, event_ip_u:
1677858023804397383 EM CNN  ENDWORK Yes 15 ip_name=17, event_type=2, event_ip_use=0, (
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| iormsssozseososesealoma Jesco | | | | lipname-is
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1677858023805081623 DTA IMPO ip_name=0
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Run Window Help
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Figure 4-10 Operation for Debugging (10)

The [Show View] dialog box is opened by selecting [Window] -> [Show View] -> [Other...]. Selecting
[Renesas R-Car Trace] -> [System Performance — DTA] and clicking on the [Open] button also opens the

view for the DTA.

type filter text

= Java

(= Java Browsing
(=1TTng
(=Make
= 0omph
= Remote Systems
[ Renesas QE
~ (= Renesas R-Car Trace
73 QOS Control (Experimental)
7u: System Performance - ARM Performance Monitor Counters (PMU) (Experimental)
7 System Performance - Bus Monitor (QOS trace)
7rSystem Performance - Bus Monitor (QoS trace) (Experimental)
System Performanc TA Trace I
& System Performance - DTA Trace (Experimental)
Sk System Performance - ETM Call Flow Trace
b system Performance - ETM Call Flow Trace (Experimental)
» (= Scripting
(=Target Explorer Views
= Terminal

» (=Tracing
» (=Version Control (Team)

Cancel

Figure 4-11  Operation for Debugging (11)
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products
outside of such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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